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Disclaimer

Copyright (C) 2004 Chua Wen Kiat. 

This program is free software; you can redistribute it and/or modify it under the terms of the GNU General 
Public License as published by the Free Software Foundation; either version 2 of the License, or (at your 
option) any later version. 

This program is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY; without even the 
implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the GNU General Public 
License for more details. 

General Notes

1. This is an Unofficial Ubuntu 4.10 Starter Guide. It is not associated with Ubuntu and Canonical Ltd. 
2. Guide is tested on a full installation of Intel x86 Ubuntu 4.10 (Warty Warthog) 
3. If you see "$", means you have to execute the command in Terminal mode (Applications -> System 

Tools -> Terminal) 
4. To download file, right click on the link -> select "Save Link As..." -> make sure file name and 

extension are correct 
5. "sudo" means superuser do. "sudo" will prompt for "Password:". Please specify your user password 
6. If you are tired of typing "sudo" all the time, switch to root user by issuing "sudo -s -H" followed by 

your user password 
7. For any feedbacks, suggestions, discussions and bugs report to the author, please post your 

comments: Here 
8. May the "humanity to others" spirit be with you always... 

Topics

Getting Started

1. What is Ubuntu?   
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2. Where to download Ubuntu?   
3. Where to find help for Ubuntu?   
4. Where to find a list of all the programs/libraries that comes with Ubuntu?   
5. How to download this entire guide?   

Repositories

1. How to add extra repositories?   
2. How to backup/restore downloaded repositories cache?   

Ubuntu Updates

1. How to manually update Ubuntu?   
2. How to automatically update Ubuntu?   

Add-On Applications

1. How to install Flash Plug-in for Mozilla Firefox?   
2. How to install PDF Reader (Adobe Acrobat Reader)?   
3. How to install PDF Reader (Adobe Acrobat Reader) Plug-in for Mozilla Firefox?   
4. How to install Newsreader (Pan)?   
5. How to install RSS and Atom feed aggregator (Sage) extension for Mozilla Firefox?   
6. How to install Download Manager (Downloader for X)?   
7. How to install FTP Client (gFTP)?   
8. How to install P2P BitTorrent Client (Azureus)?   
9. How to install P2P Gnutella Client (LimeWire)?   
10.How to install P2P eMule Client (aMule)?   
11.How to install Messenger (Skype)?   
12.How to install WinPopup (LinPopUp)?   
13.How to install RAR archiver (rar)?   
14.How to install extra Fonts?   
15.How to install Multimedia Codecs?   
16.How to install DVD playback capability?   
17.How to install Multimedia Player (XMMS)?   
18.How to install Multimedia Player (RealPlayer)?   
19.How to install Multimedia Player (xine-ui)?   
20.How to install Multimedia Plug-in for Mozilla Firefox (Pentium 4)?   
21.How to install Multimedia Plug-in for Mozilla Firefox (Non-Pentium 4)?   
22.How to install Audio Editor (Audacity)?   
23.How to install J2SE Runtime Environment (JRE)?   
24.How to install J2SE Runtime Environment (JRE) Plug-in for Mozilla Firefox?   
25.How to install Web Authoring System (Nvu)?   
26.How to install Project Management Application (Planner)?   
27.How to install Desktop Publishing Application (Scribus)?   
28.How to install Partition Magic Clone (QTParted)?   
29.How to install Firewall (Firestarter)?   

Hardware

1. How to list the partition tables?   
2. How to list file system disk space usage?   
3. How to list mounted devices?   
4. How to create symbolic link for /dev/dvd?   
5. How to mount/unmount CD/DVD-ROM manually, and show all hidden and associated files?   
6. How to forcefully unmount CD/DVD-ROM manually?   
7. How to install NVIDIA graphics driver?   
8. How to disable NVIDIA graphics logo on GNOME startup?   
9. How to enhance NVIDIA graphics performance?   
10.How to install PalmOS Devices?   

CD/DVD Burning

1. How to burn files into CD/DVD?   
2. How to duplicate CD/DVD?   
3. How to create Image (ISO) file from CD/DVD?   



4. How to create Image (ISO) file from folder?   
5. How to burn Image (ISO) file into CD/DVD?   
6. How to mount/unmount Image (ISO) file without burning?   
7. How to blank CD/DVD-RW?   
8. How to set/change the burn speed for CD/DVD Burner?   
9. How to enable burnproof for CD/DVD Burner?   
10.How to enable overburn for CD/DVD? Burner?   
11.How to generate MD5 checksum file?   
12.How to check MD5 checksum of file?   

Networking

1. How to configure network connections?   
2. How to change computer name?   
3. How to change computer descriptions?   
4. How to change computer Domain/Workgroup?   
5. How to access network folder without mounting?   
6. How to mount/unmount network folder manually?   
7. How to mount/unmount network folder manually, and allow all users to read/write?   
8. How to mount network folder on boot-up?   
9. How to mount network folder on boot-up, and allow all users to read/write?   

Security

1. What are the basic things I need to know about securing my Ubuntu?   
2. How to disable all interactive editing control for GRUB menu?   
3. How to disable history listing in Console mode?   
4. How to disable Ctrl+Alt+Del from restarting computer in Console mode?   
5. How to enable prompt before removal and overwritten of files in Console mode?   

Rescue Mode

1. How to gain root user access without login?   
2. How to modify kernel boot-up arguments, to gain root user access?   
3. How to use Ubuntu Installation CD, to gain root user access?   
4. How to change root user/main user password if forgotten?   
5. How to change GRUB menu password if forgotten?   
6. How to restore GRUB menu after Windows installation?   
7. How to add Windows entry into GRUB menu?   
8. How to read Linux partitions (ext2, ext3) in Windows?   

Windows

1. How to mount/unmount Windows partition (NTFS) manually, and allow all users to read only?   
2. How to mount/unmount Windows partition (FAT) manually, and allow all users to read/write?   
3. How to mount Windows partition (NTFS) on boot-up, and allow all users to read only?   
4. How to mount Windows partition (FAT) on boot-up, and allow all users to read/write?   

Users Administration

1. How to set/change/enable root user password?   
2. How to disable root user account?   
3. How to allow root user to login into GNOME?   
4. How to switch to root user in Terminal mode?   
5. How to add/edit/delete system users?   
6. How to add/edit/delete system groups?   
7. How to automatic login into GNOME (not secure)?   
8. How to allow more sudoers?   
9. How to explicitly destroy the "sudo" session?   
10.How to use "sudo" without prompt for password (not secure)?   
11.How to browse/edit User Programs Menu?   
12.How to browse/edit All Users Programs Menu?   
13.How to change file/folder permissions?   
14.How to change file/folder ownership?   
15.How to change file/folder group ownership?   



Samba Server

1. How to install Samba Server for file sharing service?   
2. How to add/edit/delete network users?   
3. How to share home folder with read only permission (Authentication=Yes)?   
4. How to share home folder with read/write permissions (Authentication=Yes)?   
5. How to share group folder with read only permission (Authentication=Yes)?   
6. How to share group folder with read/write permissions (Authentication=Yes)?   
7. How to share public folder with read only permission (Authentication=Yes)?   
8. How to share public folder with read/write permissions (Authentication=Yes)?   
9. How to share public folder with read only permission (Authentication=No)?   
10.How to share public folder with read/write permissions (Authentication=No)?   

SSH Server

1. How to install SSH Server for remote administration service?   
2. How to SSH into remote Ubuntu machine?   
3. How to copy file/folder from remote Ubuntu machine into local machine (scp)?   
4. How to copy file/folder from local machine into remote Ubuntu machine (scp)?   
5. How to copy file/folder from remote Ubuntu machine into local machine (rsync)?   
6. How to copy file/folder from local machine into remote Ubuntu machine (rsync)?   
7. How to SSH into remote Ubuntu machine via Windows machine?   
8. How to copy file/folder from/into remote Ubuntu machine via Windows machine?   

DHCP Server

1. How to install DHCP Server for automatic IP address assignment?   

Database Server

1. How to install MYSQL Database Server?   

Apache HTTP Server

1. How to install Apache HTTP Server for HTTP (Web) Server service?   
2. How to install PHP for Apache HTTP Server?   
3. How to install MYSQL for Apache HTTP Server?   

Tips & Tricks

1. How to apt-get the easy way (Synaptic)?   
2. How to load Web site faster in Mozilla Firefox (disable IPv6)?   
3. How to disable beep sound for link find function in Mozilla Firefox?   
4. How to open each folder in the same window in Nautilus?   
5. How to show all hidden files in Nautilus?   
6. How to show Desktop Icons (Computer, Home, Trash)?   
7. How to turn on Num Lock when login into GNOME?   
8. How to keep the content of clipboard into memory in GNOME?   
9. How to run programs on startup when login into GNOME?   
10.How to change default file type "Open with" program?   
11.How to restart GNOME without rebooting computer?   
12.How to switch to Console mode in GNOME?   
13.How to disable beep sound in Terminal mode?   
14.How to remount /etc/fstab without rebooting?   
15.How to unhide GRUB menu on boot-up?   
16.How to change the timeout seconds for GRUB menu on boot-up?   
17.How to change default Operating System boot-up for GRUB menu?   
18.How to temporary skip boot-up service?   
19.How to permanently disable/enable boot-up service?   
20.How to upgrade from Warty Warthog to Hoary Hedgehog (Beta)?   



Troubleshooting

1. Configuring network interfaces... (taking too long to load)   
2. Synchronizing clock to ntp.ubuntulinux.org... (taking too long to load)   
3. modprobe: FATAL: Error inserting...   
4. acpi_power_off called   
5. Sorry, no mixer elements and/or devices found   
6. How to disable system date/time from being reset to UTC (GMT)?   
7. How to forcefully empty Trash?   
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Getting Started

Q: What is Ubuntu?

1. http://www.ubuntulinux.org/ubuntu   

Q: Where to download Ubuntu?

1. http://www.ubuntulinux.org/download   

Q: Where to find help for Ubuntu?
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3. Ubuntu Wiki   
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Q: Where to find a list of all the programs/libraries that comes with Ubuntu?

1. http://distrowatch.com/ubuntu   
2. Result of dpkg -l: Here 

Q: How to download this entire guide?

1. Read General Notes 
2. Download ubuntu4.10.tar: Here 

3. $ cd browse_to_your_download_folder
$ tar xvf ubuntu4.10.tar

Repositories

Q: How to add extra repositories?

1. Read General Notes 

2. $ sudo cp /etc/apt/sources.list /etc/apt/sources.list_backup
$ sudo gedit /etc/apt/sources.list

3. Find this section 

...
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## Uncomment the following two lines to fetch updated software from the network
# deb http://archive.ubuntu.com/ubuntu warty main restricted
# deb-src http://archive.ubuntu.com/ubuntu warty main restricted

## Uncomment the following two lines to add software from the 'universe'
## repository.
## N.B. software from this repository is ENTIRELY UNSUPPORTED by the Ubuntu
## team, and may not be under a free licence. Please satisfy yourself as to
## your rights to use the software. Also, please note that software in
## universe WILL NOT receive any review or updates from the Ubuntu security
## team.
# deb http://archive.ubuntu.com/ubuntu warty universe
# deb-src http://archive.ubuntu.com/ubuntu warty universe

# deb http://security.ubuntu.com/ubuntu warty-security main restricted
# deb-src http://security.ubuntu.com/ubuntu warty-security main restricted
...

4. Replace with the following lines 

## Uncomment the following two lines to fetch updated software from the network
deb http://archive.ubuntu.com/ubuntu/ warty main restricted
deb-src http://archive.ubuntu.com/ubuntu/ warty main restricted

## Uncomment the following two lines to add software from the 'universe'
## repository.
## N.B. software from this repository is ENTIRELY UNSUPPORTED by the Ubuntu
## team, and may not be under a free licence. Please satisfy yourself as to
## your rights to use the software. Also, please note that software in
## universe WILL NOT receive any review or updates from the Ubuntu security
## team.
deb http://archive.ubuntu.com/ubuntu/ warty universe
deb-src http://archive.ubuntu.com/ubuntu/ warty universe

deb http://security.ubuntu.com/ubuntu/ warty-security main restricted
deb-src http://security.ubuntu.com/ubuntu/ warty-security main restricted

deb http://archive.ubuntu.com/ubuntu/ warty multiverse
deb-src http://archive.ubuntu.com/ubuntu/ warty multiverse

deb ftp://ftp.nerim.net/debian-marillat/ stable main
deb ftp://ftp.nerim.net/debian-marillat/ unstable main
deb ftp://ftp.nerim.net/debian-marillat/ testing main

5. Save the edited file (sample) 

6. $ sudo apt-get update

Q: How to backup/restore downloaded repositories cache?

1. Read General Notes 
2. To backup downloaded repositories cache 

$ mkdir -p $HOME/backup/var/lib/
$ sudo cp -R /var/lib/apt/ $HOME/backup/var/lib/
$ mkdir -p $HOME/backup/var/cache/
$ sudo cp -R /var/cache/apt/ $HOME/backup/var/cache/
$ mkdir -p $HOME/backup/etc/apt
$ sudo cp -R /etc/apt/ $HOME/backup/etc/
$ sudo chown -R $USER $HOME/backup/

3. To restore downloaded repositories cache 

$ sudo cp -fR $HOME/backup/var/* /var/
$ sudo cp -fR $HOME/backup/etc/apt/* /etc/apt/

Ubuntu Updates

Q: How to manually update Ubuntu?

1. Read General Notes 

http://ubuntuguide.org/4.10/sample/sources.list_extrarepositories


2. Read How to add extra repositories? 

3. $ sudo apt-get update
$ sudo apt-get upgrade

Q: How to automatically update Ubuntu?

1. Read General Notes 
2. Read How to add extra repositories? 

3. e.g. Automatically perform update at midnight everyday
     * * * * * means minute hour day month year

4. $ sudo gedit /root/.autoupdates

5. Insert the following lines into the new file 

PATH=/usr/local/sbin:/usr/local/bin:/usr/sbin:/usr/bin:/sbin:/bin:/usr/X11R6/bin
/usr/bin/apt-get update
/usr/bin/apt-get -y upgrade

6. Save the edited file (sample) 

7. $ sudo chmod 500 /root/.autoupdates
$ export EDITOR=gedit && sudo crontab -e

8. Append the following line at the end of file 

00 00 * * * /root/.autoupdates

9. Save the edited file 

Add-On Applications

Q: How to install Flash Plug-in for Mozilla Firefox?

1. Read General Notes 
2. Read How to add extra repositories? 

3. $ sudo apt-get install flashplayer-mozilla

Q: How to install PDF Reader (Adobe Acrobat Reader)?

1. Read General Notes 
2. Read How to add extra repositories? 

3. $ sudo apt-get install acroread

4. Read How to restart GNOME without rebooting computer? 
5. Applications -> Graphics -> Acrobat Reader 

Q: How to install PDF Reader (Adobe Acrobat Reader) Plug-in for Mozilla Firefox?

1. Read General Notes 
2. Read How to add extra repositories? 

3. $ sudo apt-get install acroread-plugin

Q: How to install Newsreader (Pan)?

1. Read General Notes 
2. Read How to add extra repositories? 

3. $ sudo apt-get install pan

4. Read How to restart GNOME without rebooting computer? 
5. Applications -> Internet -> Pan Newsreader 

Q: How to install RSS and Atom feed aggregator (Sage) extension for Mozilla Firefox?

http://ubuntuguide.org/4.10/sample/autoupdates_autoupdate


1. Read General Notes 
2. Download Sage: Here or Here 

Q: How to install Download Manager (Downloader for X)?

1. Read General Notes 
2. Read How to add extra repositories? 

3. $ sudo apt-get install d4x

4. Read How to restart GNOME without rebooting computer? 
5. Applications -> Internet -> Downloader for X 

Q: How to install FTP Client (gFTP)?

1. Read General Notes 
2. Read How to add extra repositories? 

3. $ sudo apt-get install gftp

4. Read How to restart GNOME without rebooting computer? 
5. Applications -> Internet -> gFTP Client 

Q: How to install P2P BitTorrent Client (Azureus)?

1. Read General Notes 
2. Read How to install J2SE Runtime Environment (JRE)? 
3. Download Azureus_2.2.0.2_linux.GTK.tar.bz2: Here or Here 

4. $ cd browse_to_your_download_folder
$ sudo tar jxvf Azureus_2.2.0.2_linux.GTK.tar.bz2 -C /opt/
$ sudo chown -R root:root /opt/azureus/
$ nautilus applications:///Internet

5. File Browser: Internet 

File Menu -> Create Launcher

Basic Tab ->
Name: Azureus
Command: /opt/azureus/azureus
Icon: /opt/azureus/Azureus.png

6. Read How to restart GNOME without rebooting computer? 
7. Applications -> Internet -> Azureus 

Q: How to install P2P Gnutella Client (LimeWire)?

1. Read General Notes 
2. Read How to install J2SE Runtime Environment (JRE)? 
3. Download LimeWireLinux.bin: Here or Here 

4. $ cd browse_to_your_download_folder
$ sudo sh LimeWireLinux.bin

5. LimeWire_Installer 

Choose Install Folder Tab ->
Where Would You Like to Install?
/opt/LimeWire

6. $ nautilus applications:///Internet

7. File Browser: Internet 

File Menu -> Create Launcher

Basic Tab ->
Name: LimeWire
Command: /opt/LimeWire/LimeWire

8. Read How to restart GNOME without rebooting computer? 
9. Applications -> Internet -> LimeWire 

Q: How to install P2P eMule Client (aMule)?

http://www.limewire.com/english/content/downloadfree.shtml
http://mirror.dls.filefront.com/limewire/LimeWireLinux.bin
http://azureus.sourceforge.net/download.php
http://voxel.dl.sourceforge.net/sourceforge/azureus/Azureus_2.2.0.2_linux.GTK.tar.bz2
http://sage.mozdev.org/installation.html
http://ftp.mozilla.org/pub/mozilla.org/extensions/sage/sage-1.3-fx.xpi


1. Read General Notes 
2. Read How to add extra repositories? 

3. $ sudo apt-get install amule

4. Read How to restart GNOME without rebooting computer? 
5. Applications -> Internet -> aMule 

Q: How to install Messenger (Skype)?

1. Read General Notes 
2. Download skype_staticQT-1.0.0.1.tar.bz2: Here or Here 

3. $ cd browse_to_your_download_folder
$ sudo tar jxvf skype_staticQT-1.0.0.1.tar.bz2 -C /opt/
$ sudo chown -R root:root /opt/skype_staticQT-1.0.0.1/
$ nautilus applications:///Internet

4. File Browser: Internet 

File Menu -> Create Launcher

Basic Tab ->
Name: Skype
Command: /opt/skype_staticQT-1.0.0.1/skype
Icon: /opt/skype_staticQT-1.0.0.1/icons/skype_48_32.png

5. Read How to restart GNOME without rebooting computer? 
6. Applications -> Internet -> Skype 

Q: How to install WinPopup (LinPopUp)?

1. Read General Notes 
2. Read How to add extra repositories? 

3. $ sudo apt-get install libgtk1.2

4. Read How to install Samba Server for file sharing service? 
5. Download linpopup_1.2.0-7_i386.deb: Here or Here 

6. $ cd browse_to_your_download_folder
$ sudo dpkg -i linpopup_1.2.0-7_i386.deb
$ nautilus applications:///Accessories

7. File Browser: Accessories 

File Menu -> Create Launcher

Basic Tab ->
Name: LinPopUp
Command: linpopup
Icon: /usr/share/pixmaps/linpopup.xpm

8. Read How to restart GNOME without rebooting computer? 
9. Applications -> Accessories -> LinPopUp 

Q: How to install RAR archiver (rar)?

1. Read General Notes 
2. Read How to add extra repositories? 

3. $ sudo apt-get install rar

4. Applications -> Accessories -> Archive Manager 

Q: How to install extra Fonts?

1. Read General Notes 
2. Read How to add extra repositories? 

3. $ sudo apt-get install xfonts-intl-arabic
$ sudo apt-get install xfonts-intl-asian
$ sudo apt-get install xfonts-intl-chinese
$ sudo apt-get install xfonts-intl-chinese-big
$ sudo apt-get install xfonts-intl-european
$ sudo apt-get install xfonts-intl-japanese
$ sudo apt-get install xfonts-intl-japanese-big
$ sudo apt-get install xfonts-intl-phonetic
$ sudo apt-get install msttcorefonts

http://packages.debian.org/unstable/net/linpopup
http://ftp.us.debian.org/debian/pool/main/l/linpopup/linpopup_1.2.0-7_i386.deb
http://www.skype.com/products/skype/linux
http://download.skype.com/linux/skype_staticQT-1.0.0.1.tar.bz2


Q: How to install Multimedia Codecs?

1. Read General Notes 
2. Read How to add extra repositories? 

3. $ sudo apt-get install gstreamer0.8-plugins
$ sudo apt-get install w32codecs

Q: How to install DVD playback capability?

1. Read General Notes 
2. Read How to add extra repositories? 

3. $ sudo apt-get install libdvdcss2

Q: How to install Multimedia Player (XMMS)?

1. Read General Notes 
2. Read How to add extra repositories? 
3. Read How to install Multimedia Codecs? 

4. $ sudo apt-get install xmms

5. Read How to restart GNOME without rebooting computer? 
6. Applications -> Multimedia -> XMMS 

Q: How to install Multimedia Player (RealPlayer)?

1. Read General Notes 
2. Download realplay-10.0.2.608-linux-2.2-libc6-gcc32-i586.bin: Here or Here 

3. $ cd browse_to_your_download_folder
$ chmod +x realplay-10.0.2.608-linux-2.2-libc6-gcc32-i586.bin
$ sudo ./realplay-10.0.2.608-linux-2.2-libc6-gcc32-i586.bin

Enter the complete path to the directory where you want
RealPlayer to be installed.  You must specify the full
pathname of the directory and have write privileges to
the chosen directory.
Directory:  [/home/chua/RealPlayer]: /opt/RealPlayer

You have selected the following RealPlayer configuration:
Destination:            /opt/RealPlayer
Enter [F]inish to begin copying files, or [P]revious to go
back to the previous prompts: [F]: F

Copying RealPlayer files...configure system-wide symbolic links? [Y/n]: Y

enter the prefix for symbolic links [/usr]: /usr

4. Read How to restart GNOME without rebooting computer? 
5. Applications -> Multimedia -> RealPlayer 10 

Q: How to install Multimedia Player (xine-ui)?

1. Read General Notes 
2. Read How to add extra repositories? 
3. Read How to install Multimedia Codecs? 
4. Read How to install DVD playback capability? 
5. Read How to create symbolic link for /dev/dvd? 

6. $ sudo apt-get install xine-ui

7. Read How to restart GNOME without rebooting computer? 
8. Applications -> Multimedia -> xine 

Q: How to install Multimedia Plug-in for Mozilla Firefox (Pentium 4)?

1. Read General Notes 
2. Read How to add extra repositories? 
3. Read How to install Multimedia Codecs? 

4. $ sudo apt-get install mozilla-mplayer
$ sudo apt-get install mplayer-fonts

Q: How to install Multimedia Plug-in for Mozilla Firefox (Non-Pentium 4)?

1. Read General Notes 

https://player.helixcommunity.org/2004/downloads
https://helixcommunity.org/download.php/800/realplay-10.0.2.608-linux-2.2-libc6-gcc32-i586.bin


2. Read How to add extra repositories? 
3. Read How to install Multimedia Codecs? 

4. $ sudo apt-get install totem-xine
$ sudo apt-get install mozplugger
$ sudo cp /etc/mozpluggerrc /etc/mozpluggerrc_backup
$ sudo gedit /etc/mozpluggerrc

5. Find this section 

...
application/x-mplayer2: wmv,asf,mov: Windows Media
video/x-ms-asf: asf,asx,wma,wax,wmv,wvx: Windows Media
video/x-ms-wmv: wmv: Windows Media
        stream noisy ignore_errors: mplayer -really-quiet -nojoystick -nofs -wid $window -vo 
xv,x11 -ao esd,alsa9,oss,arts,null -zoom -osdlevel 0 "$file" </dev/null
...

6. Add the following line below it 

        stream noisy ignore_errors: totem "$file" </dev/null

7. Save the edited file (sample) 

8. $ rm ~/.mozilla/pluginreg.dat

Q: How to install Audio Editor (Audacity)?

1. Read General Notes 
2. Read How to add extra repositories? 

3. $ sudo apt-get install audacity
$ nautilus applications:///Multimedia

4. File Browser: Multimedia 

File Menu -> Create Launcher

Basic Tab ->
Name: Audacity
Command: audacity
Icon: /usr/share/audacity/audacity.xpm

5. Read How to restart GNOME without rebooting computer? 
6. Applications -> Multimedia -> Audacity 

Q: How to install J2SE Runtime Environment (JRE)?

1. Read General Notes 
2. Download jre-1_5_0_01-linux-i586.bin: Here (Download JRE) 

3. $ cd browse_to_your_download_folder
$ sh jre-1_5_0_01-linux-i586.bin
$ sudo mkdir /usr/java
$ sudo mv jre1.5.0_01/ /usr/java/
$ sudo chown -R root:root /usr/java/jre1.5.0_01/
$ sudo ln -s /usr/java/jre1.5.0_01/bin/java /usr/bin/java
$ sudo ln -s /usr/java/jre1.5.0_01/bin/java_vm /usr/bin/java_vm
$ sudo cp /etc/bash.bashrc /etc/bash.bashrc_backup
$ sudo gedit /etc/bash.bashrc

4. Append the following lines at the end of file 

JAVA_HOME=/usr/java/jre1.5.0_01
export JAVA_HOME
PATH=$PATH:$JAVA_HOME/bin
export PATH

5. Save the edited file (sample) 

6. $ java -version

Q: How to install J2SE Runtime Environment (JRE) Plug-in for Mozilla Firefox?

1. Read General Notes 
2. Read How to install J2SE Runtime Environment (JRE)? 

3. $ sudo ln -s /usr/java/jre1.5.0_01/plugin/i386/ns7/libjavaplugin_oji.so 
/usr/lib/mozilla/plugins/
$ sudo ln -s /usr/java/jre1.5.0_01/plugin/i386/ns7/libjavaplugin_oji.so /usr/lib/mozilla-

http://ubuntuguide.org/4.10/sample/bash.bashrc_jre
http://java.sun.com/j2se/1.5.0/download.jsp
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firefox/plugins/

Q: How to install Web Authoring System (Nvu)?

1. Read General Notes 
2. Read How to add extra repositories? 

3. $ sudo apt-get install libstdc++2.10-glibc2.2

4. Download nvu-0.80-pc-linux2.4.23-gnu.tar.bz2: Here or Here 

5. $ cd browse_to_your_download_folder
$ sudo tar jxvf nvu-0.80-pc-linux2.4.23-gnu.tar.bz2 -C /opt/
$ sudo chown -R root:root /opt/nvu-0.80/
$ sudo /opt/nvu-0.80/nvu
$ nautilus applications:///Office

6. File Browser: Office 

File Menu -> Create Launcher

Basic Tab ->
Name: Nvu
Command: /opt/nvu-0.80/nvu
Icon: /opt/nvu-0.80/icons/mozicon50.xpm

7. Read How to restart GNOME without rebooting computer? 
8. Applications -> Office -> Nvu 

Q: How to install Project Management Application (Planner)?

1. Read General Notes 
2. Read How to add extra repositories? 

3. $ sudo apt-get install planner

4. Read How to restart GNOME without rebooting computer? 
5. Applications -> Office -> Project Management 

Q: How to install Desktop Publishing Application (Scribus)?

1. Read General Notes 
2. Read How to add extra repositories? 

3. $ sudo apt-get install scribus

4. Read How to restart GNOME without rebooting computer? 
5. Applications -> Office -> Scribus 

Q: How to install Partition Magic Clone (QTParted)?

1. Read General Notes 
2. Read How to add extra repositories? 

3. $ sudo apt-get install qtparted
$ nautilus applications:///System

4. File Browser: System Tools 

Remove the existing QTParted Icon

File Menu -> Create Launcher

Basic Tab ->
Name: QTParted
Command: gksudo qtparted
Icon: /usr/share/pixmaps/qtparted.xpm

5. Read How to restart GNOME without rebooting computer? 
6. Applications -> System Tools -> QTParted 

Q: How to install Firewall (Firestarter)?

1. Read General Notes 
2. Read How to add extra repositories? 

3. $ sudo apt-get install firestarter
$ nautilus applications:///Internet

http://www.nvu.com/download.html
http://cvs.nvu.com/download/nvu-0.80-pc-linux2.4.23-gnu.tar.bz2


4. File Browser: Internet 

Remove the existing Firestarter Firewall Tool Icon

5. $ nautilus applications:///System

6. File Browser: System Tools 

Remove the existing Firestarter Firewall Tool Icon

File Menu -> Create Launcher

Basic Tab ->
Name: Firestarter Firewall Tool
Command: gksudo /usr/sbin/firestarter
Icon: /usr/share/pixmaps/firestarter.png

7. Read How to restart GNOME without rebooting computer? 
8. Applications -> System Tools -> Firestarter Firewall Tool 

Hardware

Q: How to list the partition tables?

1. Read General Notes 

2. $ sudo fdisk -l

Q: How to list file system disk space usage?

1. Read General Notes 

2. $ df -T -h

Q: How to list mounted devices?

1. Read General Notes 

2. $ mount

Q: How to create symbolic link for /dev/dvd?

1. Read General Notes 

2. $ sudo ln -sf /dev/cdrom /dev/dvd
$ sudo cp /etc/udev/udev.rules /etc/udev/udev.rules_backup
$ sudo gedit /etc/udev/udev.rules

3. Find this line 

...
BUS="ide", KERNEL="hd[a-z]", PROGRAM="/etc/udev/cdsymlinks.sh %k", SYMLINK="%c{1} %c{2}"
...

4. Replace with the following line 

BUS="ide", KERNEL="hd[a-z]", SYMLINK="cdrom dvd"

5. Save the edited file (sample) 

Q: How to mount/unmount CD/DVD-ROM manually, and show all hidden and 
associated files?

1. Read General Notes 
2. e.g. Assumed that /media/cdrom0/ is the location of CD/DVD-ROM

3. Mount CD/DVD-ROM 

http://ubuntuguide.org/4.10/sample/udev.rules_symbolicdevdvd


$ sudo mount /media/cdrom0/ -o unhide

4. Unmount CD/DVD-ROM 

$ sudo umount /media/cdrom0/

Q: How to forcefully unmount CD/DVD-ROM manually?

1. Read General Notes 
2. e.g. Assumed that /media/cdrom0/ is the location of CD/DVD-ROM

3. $ sudo umount /media/cdrom0/ -l

Q: How to install NVIDIA graphics driver?

1. Read General Notes 
2. Read How to add extra repositories? 

3. $ sudo apt-get install nvidia-glx
$ sudo apt-get install nvidia-settings
$ sudo nvidia-glx-config enable
$ nautilus applications:///System

4. File Browser: System Tools 

File Menu -> Create Launcher

Basic Tab ->
Name: NVIDIA Settings
Command: nvidia-settings

5. Read How to restart GNOME without rebooting computer? 
6. Applications -> System Tools -> NVIDIA Settings 

Q: How to disable NVIDIA graphics logo on GNOME startup?

1. Read General Notes 
2. Read How to install NVIDIA graphics driver? 

3. $ sudo cp /etc/X11/XF86Config-4 /etc/X11/XF86Config-4_backup
$ sudo gedit /etc/X11/XF86Config-4

4. Find this section 

...
Section "Device"
        Identifier      "NVIDIA Corporation NV34M [GeForce FX Go 5200]"
        Driver          "nvidia"
        BusID           "PCI:1:0:0"
...

5. Add the following line below it 

        Option          "NoLogo"

6. Save the edited file (sample) 
7. Read How to restart GNOME without rebooting computer? 

Q: How to enhance NVIDIA graphics performance?

1. Read General Notes 
2. Read How to install NVIDIA graphics driver? 

3. $ sudo cp /etc/X11/XF86Config-4 /etc/X11/XF86Config-4_backup
$ sudo gedit /etc/X11/XF86Config-4

4. Find this section 

...
Section "Device"
        Identifier      "NVIDIA Corporation NV34M [GeForce FX Go 5200]"
        Driver          "nvidia"
        BusID           "PCI:1:0:0"
...

5. Add the following lines below it 

http://ubuntuguide.org/4.10/sample/XF86Config-4_disablenvidialogo


        Option          "RenderAccel"           "true"
        Option          "NvAGP"                 "1"

6. Save the edited file (sample) 
7. Read How to restart GNOME without rebooting computer? 

Q: How to install PalmOS Devices?

1. Read General Notes 

2. $ sudo ln -sf /dev/ttyUSB1 /dev/pilot

3. Computer -> Desktop Preferences -> PalmOS Devices 
4. Follow the instructions on screen 

CD/DVD Burning

Q: How to burn files into CD/DVD?

1. Read General Notes 

2. $ nautilus burn:///

3. File Browser: CD/DVD Creator 

Drag files into window

File Menu -> Write to Disc... -> Write

Q: How to duplicate CD/DVD?

1. Read General Notes 
2. Read How to create Image (ISO) file from CD/DVD? 
3. Read How to burn Image (ISO) file into CD/DVD? 

Q: How to create Image (ISO) file from CD/DVD?

1. Read General Notes 
2. e.g. Assumed that /dev/cdrom is the location of CD/DVD-ROM

3. $ dd if=/dev/cdrom of=file.iso bs=1024

Q: How to create Image (ISO) file from folder?

1. Read General Notes 
2. e.g. Assumed that Folder/ is the location of folder

3. $ mkisofs -RJ -o file.iso Folder/ 

Q: How to burn Image (ISO) file into CD/DVD?

1. Read General Notes 

2. Right click on Image (ISO) file -> Write to Disc... -> Write

Q: How to mount/unmount Image (ISO) file without burning?

1. Read General Notes 
2. Mount Image (ISO) file 

$ sudo mkdir /media/iso
$ sudo modprobe loop
$ sudo mount file.iso /media/iso/ -t iso9660 -o loop

3. Unmount Image (ISO) file 

http://ubuntuguide.org/4.10/sample/XF86Config-4_enhancenvidiaperformance


$ sudo umount /media/iso/

Q: How to blank CD/DVD-RW?

1. Read General Notes 
2. e.g. Assumed that /dev/cdrom is the location of CD/DVD-ROM

3. $ sudo umount /dev/cdrom
$ cdrecord dev=/dev/cdrom blank=all

Q: How to set/change the burn speed for CD/DVD Burner?

1. Read General Notes 
2. Applications -> System Tools -> Configuration Editor 
3. GConf editor - 

/ -> apps -> nautilus-cd-burner -> default_speed (set/change the burn speed for CD/DVD Burner)

Q: How to enable burnproof for CD/DVD Burner?

1. Read General Notes 
2. Applications -> System Tools -> Configuration Editor 
3. GConf editor - 

/ -> apps -> nautilus-cd-burner -> burnproof (Checked)

Q: How to enable overburn for CD/DVD? Burner?

1. Read General Notes 
2. Applications -> System Tools -> Configuration Editor 
3. GConf editor - 

/ -> apps -> nautilus-cd-burner -> overburn (Checked)

Q: How to generate MD5 checksum file?

1. Read General Notes 

2. $ md5sum file.iso > file.iso.md5

Q: How to check MD5 checksum of file?

1. Read General Notes 
2. e.g. file.iso and file.iso.md5 must be in the same folder

3. $ md5sum -c file.iso.md5

Networking

Q: How to configure network connections?

1. Read General Notes 
2. Computer -> System Configuration -> Networking 
3. Network Settings 

Connections Tab -> Add/Properties/Delete/Activate/Deactivate network connections

DNS Tab -> DNS Servers -> Add/Delete DNS servers

Q: How to change computer name?

1. Read General Notes 
2. Computer -> System Configuration -> Networking 
3. Network Settings 



General Tab -> Host Settings -> Hostname: Fill in the computer name

Q: How to change computer descriptions?

1. Read General Notes 
2. Read How to install Samba Server for file sharing service? 
3. Computer -> System Configuration -> Networking 
4. Network Settings 

General Tab -> Windows Networking ->
Enable Windows networking (Checked)
Descriptions: Fill in the computer descriptions

Q: How to change computer Domain/Workgroup?

1. Read General Notes 
2. Read How to install Samba Server for file sharing service? 
3. Computer -> System Configuration -> Networking 
4. Network Settings 

General Tab -> Windows Networking ->
Enable Windows networking (Checked)
Domain / Workgroup: Fill in the computer Domain/Workgroup

Q: How to access network folder without mounting?

1. Read General Notes 
2. e.g. Network computer's IP: 192.168.0.1

     Shared folder's name: linux

3. Applications -> Run Application... 
4. Run Application 

smb://192.168.0.1/linux

Q: How to mount/unmount network folder manually?

1. Read General Notes 
2. Read How to install Samba Server for file sharing service? 

3. e.g. Network computer's IP: 192.168.0.1
     Network computer's Username: myusername
     Network computer's Password: mypassword
     Shared folder's name: linux
     Local mount folder: /media/sharename

4. Mount network folder 

$ sudo mkdir /media/sharename
$ sudo mount //192.168.0.1/linux /media/sharename/ -t smbfs -o 
username=myusername,password=mypassword

5. Unmount network folder 

$ sudo umount /media/sharename/

Q: How to mount/unmount network folder manually, and allow all users to read/write?

1. Read General Notes 
2. Read How to install Samba Server for file sharing service? 

3. e.g. Network computer's IP: 192.168.0.1
     Network computer's Username: myusername
     Network computer's Password: mypassword
     Shared folder's name: linux
     Local mount folder: /media/sharename

4. Mount network folder 

$ sudo mkdir /media/sharename
$ sudo mount //192.168.0.1/linux /media/sharename/ -o 
username=myusername,password=mypassword,dmask=777,fmask=777

5. Unmount network folder 



$ sudo umount /media/sharename/

Q: How to mount network folder on boot-up?

1. Read General Notes 
2. Read How to install Samba Server for file sharing service? 

3. e.g. Network computer's IP: 192.168.0.1
     Network computer's Username: myusername
     Network computer's Password: mypassword
     Shared folder's name: linux
     Local mount folder: /media/sharename

4. $ sudo mkdir /media/sharename
$ sudo gedit /root/.smbcredentials

5. Insert the following lines into the new file 

username=myusername
password=mypassword

6. Save the edited file (sample) 

7. $ sudo cp /etc/fstab /etc/fstab_backup
$ sudo gedit /etc/fstab

8. Append the following line at the end of file 

//192.168.0.1/linux     /media/sharename  smbfs    credentials=/root/.smbcredentials       0   
    0

9. Save the edited file (sample) 
10.Read How to remount /etc/fstab without rebooting? 

Q: How to mount network folder on boot-up, and allow all users to read/write?

1. Read General Notes 
2. Read How to install Samba Server for file sharing service? 

3. e.g. Network computer's IP: 192.168.0.1
     Network computer's Username: myusername
     Network computer's Password: mypassword
     Shared folder's name: linux
     Local mount folder: /media/sharename

4. $ sudo mkdir /media/sharename
$ sudo gedit /root/.smbcredentials

5. Insert the following lines into the new file 

username=myusername
password=mypassword

6. Save the edited file (sample) 

7. $ sudo cp /etc/fstab /etc/fstab_backup
$ sudo gedit /etc/fstab

8. Append the following line at the end of file 

//192.168.0.1/linux     /media/sharename  smbfs   credentials=/root/.smbcredentials,dmask=777,
fmask=777   0       0

9. Save the edited file (sample) 
10.Read How to remount /etc/fstab without rebooting? 

Security

Q: What are the basic things I need to know about securing my Ubuntu?

1. Read General Notes 

http://ubuntuguide.org/4.10/sample/fstab_automountnetworkfolderall
http://ubuntuguide.org/4.10/sample/smbcredentials_automountnetworkfolderall
http://ubuntuguide.org/4.10/sample/fstab_automountnetworkfolder
http://ubuntuguide.org/4.10/sample/smbcredentials_automountnetworkfolder


2. Ensure hard drive is first in BIOS boot-up sequence 
1. To prevent trespassers from using Linux Installation CD which allows them to gain root user 

access 
2. To prevent trespassers from using Linux Live CD (e.g. KNOPPIX) which allows them to 

destroy/browse/share the entire hard drive 
3. To prevent trespassers from installing another Operating System 

3. Ensure a password is set for BIOS 
1. To prevent trespassers from changing the BIOS boot-up sequence 

4. Ensure computer is located at a secured place 
1. To prevent trespassers from removing computer's hard drive which allows them to 

destroy/browse/share the entire hard drive from a different computer 
2. To prevent trespassers from removing computer's on-board battery which resets the BIOS 

password 
5. Ensure passwords used on the system cannot be easily guessed 

1. To prevent trespassers from cracking your password file using brute force attacks (e.g. John 
the Ripper) 

2. Create password with minimum length of 8 characters 
3. Create password with mixture of characters/numbers, and upper/lower case 

6. Ensure interactive editing control for GRUB menu is disabled 
1. To prevent trespassers from modifying kernel boot-up arguments which allows them to have 

root user access 
2. Read How to disable all interactive editing control for GRUB menu? 

7. Ensure history listing is disabled in Console mode 
1. To prevent trespassers from seeing previously issued commands 
2. Read How to disable history listing in Console mode? 

8. Ensure Ctrl+Alt+Del is disabled in Console mode 
1. To prevent trespassers from restarting the system without permission in Console mode 
2. Read How to disable Ctrl+Alt+Del from restarting computer in Console mode? 

9. Ensure interactive option is set for remove, copy and move files in Console mode 
1. To prevent accidental removal and overwritten of files 
2. Read How to enable prompt before removal and overwritten of files in Console mode? 

10.For day to day usage, login as a normal user 
1. To prevent accidental deletion and modification of system files 
2. Read How to add/edit/delete system users? 

11.Disable root user account, use "sudo" instead 
1. To reduce the amount of time spent with root privileges, and thus the risk of inadvertently 

executing a command as root 
2. "sudo" provides a more useful audit trail (/var/log/auth.log) 
3. Read How to disable root user account? 

12.Install a Firewall 
1. A firewall does not guarantee security but it is in most environments the first line of defense 

against network based attacks 
2. Read How to install Firewall (Firestarter)? 

Q: How to disable all interactive editing control for GRUB menu?

1. Read General Notes 

2. $ grub

grub> md5crypt
Password: ****** (ubuntu)
Encrypted: $1$ZWnke0$1fzDBVjUcT1Mpdd4u/T961 (encrypted password)

grub> quit

$ sudo cp /boot/grub/menu.lst /boot/grub/menu.lst_backup
$ sudo gedit /boot/grub/menu.lst

3. Find this section 

...
## password ['--md5'] passwd
# If used in the first section of a menu file, disable all interactive editing
# control (menu entry editor and command-line)  and entries protected by the
# command 'lock'
# e.g. password topsecret
#      password --md5 $1$gLhU0/$aW78kHK1QfV3P2b2znUoe/
# password topsecret
...

4. Add the following line below it 

password --md5 $1$ZWnke0$1fzDBVjUcT1Mpdd4u/T961 (encrypted password above)

5. Save the edited file (sample) 

http://ubuntuguide.org/4.10/sample/menu.list_disableinteractiveeditinggrub


Q: How to disable history listing in Console mode?

1. Read General Notes 

2. $ rm $HOME/.bash_history
$ touch $HOME/.bash_history
$ chmod 000 $HOME/.bash_history

Q: How to disable Ctrl+Alt+Del from restarting computer in Console mode?

1. Read General Notes 

2. $ sudo cp /etc/inittab /etc/inittab_backup
$ sudo gedit /etc/inittab

3. Find this line 

...
ca:12345:ctrlaltdel:/sbin/shutdown -t1 -a -r now
...

4. Replace with the following line 

#ca:12345:ctrlaltdel:/sbin/shutdown -t1 -a -r now

5. Save the edited file (sample) 

6. $ sudo telinit q

Q: How to enable prompt before removal and overwritten of files in Console mode?

1. Read General Notes 

2. $ sudo cp /etc/bash.bashrc /etc/bash.bashrc_backup
$ sudo gedit /etc/bash.bashrc

3. Append the following lines at the end of file 

alias rm='rm -i'
alias cp='cp -i'
alias mv='mv -i'

4. Save the edited file (sample) 

Rescue Mode

Q: How to gain root user access without login?

1. Read General Notes 
2. Two common methods 

1. Read How to modify kernel boot-up arguments, to gain root user access? 
2. Read How to use Ubuntu Installation CD, to gain root user access? 

Q: How to modify kernel boot-up arguments, to gain root user access?

1. Read General Notes 
2. Boot-up your computer 
3. Press 'Esc' to enter the GRUB menu 
4. If a GRUB password is set, press 'p' to enter GRUB password 
5. Select 

Ubuntu, kernel 2.6.8.1-4-386

6. Press 'e' to edit the commands before booting 
7. Select 

kernel /boot/vmlinuz-2.6.8.1-4-386 root=/dev/hda1 ro quiet splash

http://ubuntuguide.org/4.10/sample/bash.bashrc_promptbeforeremovaloverwrittenconsole
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8. Press 'e' to edit the selected command in the boot sequence 
9. Add "rw init=/bin/bash" to the end of the arguments 

grub edit> kernel /boot/vmlinuz-2.6.8.1-4-386 root=/dev/hda1 ro quiet splash rw init=/bin/bash

10.Press 'b' to boot 

11.root@(none):/ #

Q: How to use Ubuntu Installation CD, to gain root user access?

1. Read General Notes 
2. Boot-up your computer into Ubuntu Installation CD 
3. Follow the instructions on screen till (do NOT go further than this) 

[!!] Partition disks

4. Press 'Ctrl + Alt + F2' 
5. Press 'Enter' to activate the console 

6. ~ # mkdir /ubuntu
~ # fdisk -l /dev/discs/disc0/disc
~ # mount <wherever your Ubuntu root device is> /ubuntu/
~ # chroot /ubuntu/
sh-2.05b#

Q: How to change root user/main user password if forgotten?

1. Read General Notes 
2. Read How to gain root user access without login? 
3. To change root user password 

# passwd root

4. To change main user password 

# passwd your_system_main_username

Q: How to change GRUB menu password if forgotten?

1. Read General Notes 

2. $ grub

grub> md5crypt
Password: ****** (ubuntu)
Encrypted: $1$ZWnke0$1fzDBVjUcT1Mpdd4u/T961 (encrypted password)

grub> quit

$ sudo cp /boot/grub/menu.lst /boot/grub/menu.lst_backup
$ sudo gedit /boot/grub/menu.lst

3. Find this line 

...
password --md5 $1$gLhU0/$aW78kHK1QfV3P2b2znUoe/
...

4. Replace with the following line 

password --md5 $1$ZWnke0$1fzDBVjUcT1Mpdd4u/T961 (encrypted password above)

5. Save the edited file (sample) 

Q: How to restore GRUB menu after Windows installation?

1. Read General Notes 
2. e.g. Assumed that /dev/hda1 is the location of /boot partition

3. Read How to use Ubuntu Installation CD, to gain root user access? 

4. sh-2.05b# grub

grub> root (hd0,0)
grub> setup (hd0)

http://ubuntuguide.org/4.10/sample/menu.lst_changegrubpasswordforgotten


grub> quit

Q: How to add Windows entry into GRUB menu?

1. Read General Notes 
2. e.g. Assumed that /dev/hda1 is the location of Windows partition

3. Read How to list the partition tables? 

4. $ sudo cp /boot/grub/menu.lst /boot/grub/menu.lst_backup
$ sudo gedit /boot/grub/menu.lst

5. Append the following lines at the end of file 

title           Windows 95/98/NT/2000
root            (hd0,0)
makeactive
chainloader     +1
savedefault

6. Save the edited file (sample) 

Q: How to read Linux partitions (ext2, ext3) in Windows?

1. Read General Notes 
2. Download Explore2fs: Here or Here 

Windows

Q: How to mount/unmount Windows partition (NTFS) manually, and allow all users to 
read only?

1. Read General Notes 
2. e.g. Assumed that /dev/hda1 is the location of Windows partition (NTFS)

     Local mount folder: /media/windows

3. Read How to list the partition tables? 

4. $ sudo mkdir /media/windows

5. Mount Windows partition 

$ sudo mount /dev/hda1 /media/windows -t ntfs -o umask=0222

6. Unmount Windows partition 

$ sudo umount /media/windows

Q: How to mount/unmount Windows partition (FAT) manually, and allow all users to 
read/write?

1. Read General Notes 
2. e.g. Assumed that /dev/hda1 is the location of Windows partition (FAT)

     Local mount folder: /media/windows

3. Read How to list the partition tables? 

4. $ sudo mkdir /media/windows

5. Mount Windows partition 

$ sudo mount /dev/hda1 /media/windows -t vfat -o umask=000

6. Unmount Windows partition 

$ sudo umount /media/windows

http://uranus.it.swin.edu.au/~jn/linux/explore2fs.htm
http://uranus.it.swin.edu.au/~jn/explore2fs/explore2fs-1.00pre6b.zip
http://ubuntuguide.org/4.10/sample/menu.lst_addwindowsentrygrubmenu


Q: How to mount Windows partition (NTFS) on boot-up, and allow all users to read 
only?

1. Read General Notes 
2. e.g. Assumed that /dev/hda1 is the location of Windows partition (NTFS)

     Local mount folder: /media/windows

3. Read How to list the partition tables? 

4. $ sudo mkdir /media/windows
$ sudo cp /etc/fstab /etc/fstab_backup
$ sudo gedit /etc/fstab

5. Append the following line at the end of file 

/dev/hda1       /media/windows    ntfs    umask=0222      0       0

6. Save the edited file (sample) 
7. Read How to remount /etc/fstab without rebooting? 

Q: How to mount Windows partition (FAT) on boot-up, and allow all users to 
read/write?

1. Read General Notes 
2. e.g. Assumed that /dev/hda1 is the location of Windows partition (FAT)

     Local mount folder: /media/windows

3. Read How to list the partition tables? 

4. $ sudo mkdir /media/windows
$ sudo cp /etc/fstab /etc/fstab_backup
$ sudo gedit /etc/fstab

5. Append the following line at the end of file 

/dev/hda1       /media/windows    vfat    umask=000       0       0

6. Save the edited file (sample) 
7. Read How to remount /etc/fstab without rebooting? 

Users Administration

Q: How to set/change/enable root user password?

1. Read General Notes 

2. $ sudo passwd root

Q: How to disable root user account?

1. Read General Notes 

2. $ sudo passwd -l root

Q: How to allow root user to login into GNOME?

1. Read General Notes 
2. Read How to set/change/enable root user password? 
3. Computer -> System Configuration -> Login Screen Setup 
4. Login Screen Setup 

Security Tab -> Options -> Allow root to login with GDM (Checked)

Q: How to switch to root user in Terminal mode?

1. Read General Notes 
2. Read How to set/change/enable root user password? 

http://ubuntuguide.org/4.10/sample/fstab_automountfat
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3. $ sudo -s -H (specify your user password)
 or
$ su (specify your root user password)

Q: How to add/edit/delete system users?

1. Read General Notes 
2. Computer -> System Configuration -> Users and Groups 
3. Users and Groups 

Users Tab -> Add User.../Properties/Delete users

Q: How to add/edit/delete system groups?

1. Read General Notes 
2. Computer -> System Configuration -> Users and Groups 
3. Users and Groups 

Groups Tab -> Add Group.../Properties/Delete users

Q: How to automatic login into GNOME (not secure)?

1. Read General Notes 
2. Computer -> System Configuration -> Login Screen Setup 
3. Login Screen Setup 

General Tab -> Automatic Login ->
Login a user automatically on first bootup (Checked)
Automatic login username: Select the username to automatic login

Q: How to allow more sudoers?

1. Read General Notes 

2. $ export EDITOR=gedit && sudo visudo

3. Append the following line at the end of file 

your_system_username    ALL=(ALL) ALL

4. Save the edited file (sample) 

Q: How to explicitly destroy the "sudo" session?

1. Read General Notes 

2. $ sudo -K 

Q: How to use "sudo" without prompt for password (not secure)?

1. Read General Notes 

2. $ export EDITOR=gedit && sudo visudo

3. Find this line 

...
your_system_username    ALL=(ALL) ALL
...

4. Replace with the following line 

your_system_username    ALL=(ALL) NOPASSWD: ALL

5. Save the edited file (sample) 

Q: How to browse/edit User Programs Menu?

1. Read General Notes 

2. $ nautilus applications:///

Q: How to browse/edit All Users Programs Menu?
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1. Read General Notes 

2. $ sudo nautilus applications-all-users:///

Q: How to change file/folder permissions?

1. Read General Notes 

2. Right click on file -> Properties

Permissions Tab -> Read/Write/Execute (Checked the permissions for Owner/Group/Others)

Q: How to change file/folder ownership?

1. Read General Notes 

2. $ sudo chown -R your_system_username /location_of_your_file_or_folder

Q: How to change file/folder group ownership?

1. Read General Notes 

2. $ sudo chgrp -R your_system_groupname /location_of_your_file_or_folder

Samba Server

Q: How to install Samba Server for file sharing service?

1. Read General Notes 
2. Read How to add extra repositories? 

3. $ sudo apt-get install samba
$ sudo apt-get install smbfs

Q: How to add/edit/delete network users?

1. Read General Notes 
2. Read How to install Samba Server for file sharing service? 
3. How to add network user 

1. Read How to add/edit/delete system users? 

2. $ sudo smbpasswd -a your_system_username
$ sudo gedit /etc/samba/smbusers

3. Insert the following line into the new file 

your_system_username = "your network username"

4. Save the edited file (sample) 
4. How to edit network user 

1. $ sudo smbpasswd -a your_system_username

5. How to delete network user 

1. $ sudo smbpasswd -x your_system_username

Q: How to share home folder with read only permission (Authentication=Yes)?

1. Read General Notes 
2. Read How to install Samba Server for file sharing service? 

3. $ sudo cp /etc/samba/smb.conf /etc/samba/smb.conf_backup
$ sudo gedit /etc/samba/smb.conf

4. Find this line 

...
;   security = user
...

5. Replace with the following line 
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   security = user

6. Find this section 

...
# This boolean controls whether PAM will be used for password changes
# when requested by an SMB client instead of the program listed in
# 'passwd program'. The default is 'no'.
;   pam password change = no
...

7. Add the following line below it 

   username map = /etc/samba/smbusers

8. Save the edited file (sample) 
9. Read How to add/edit/delete network users? 

10.$ sudo testparm
$ sudo /etc/init.d/samba restart

Q: How to share home folder with read/write permissions (Authentication=Yes)?

1. Read General Notes 
2. Read How to install Samba Server for file sharing service? 

3. $ sudo cp /etc/samba/smb.conf /etc/samba/smb.conf_backup
$ sudo gedit /etc/samba/smb.conf

4. Find this line 

...
;   security = user
...

5. Replace with the following line 

   security = user

6. Find this section 

...
# This boolean controls whether PAM will be used for password changes
# when requested by an SMB client instead of the program listed in
# 'passwd program'. The default is 'no'.
;   pam password change = no
...

7. Add the following line below it 

   username map = /etc/samba/smbusers

8. Find this section 

...
# By default, the home directories are exported read-only. Change next
# parameter to 'yes' if you want to be able to write to them.
   writable = no
...

9. Replace with the following lines 

# By default, the home directories are exported read-only. Change next
# parameter to 'yes' if you want to be able to write to them.
   writable = yes

10.Save the edited file (sample) 
11.Read How to add/edit/delete network users? 

12.$ sudo testparm
$ sudo /etc/init.d/samba restart

Q: How to share group folder with read only permission (Authentication=Yes)?

1. Read General Notes 
2. Read How to install Samba Server for file sharing service? 

3. $ sudo mkdir /home/group
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$ sudo chmod 777 /home/group/
$ sudo chmod +t /home/group/
$ sudo cp /etc/samba/smb.conf /etc/samba/smb.conf_backup
$ sudo gedit /etc/samba/smb.conf

4. Find this line 

...
;   security = user
...

5. Replace with the following line 

   security = user

6. Find this section 

...
# This boolean controls whether PAM will be used for password changes
# when requested by an SMB client instead of the program listed in
# 'passwd program'. The default is 'no'.
;   pam password change = no
...

7. Add the following line below it 

   username map = /etc/samba/smbusers

8. Append the following lines at the end of file 

[Group]
   comment = Group Folder
   path = /home/group
   public = yes
   writable = no
   valid users = your_system_username1 your_system_username2
   create mask = 0700
   directory mask = 0700
   force user = nobody
   force group = nogroup

9. Save the edited file (sample) 
10.Read How to add/edit/delete network users? 

11.$ sudo testparm
$ sudo /etc/init.d/samba restart

Q: How to share group folder with read/write permissions (Authentication=Yes)?

1. Read General Notes 
2. Read How to install Samba Server for file sharing service? 

3. $ sudo mkdir /home/group
$ sudo chmod 777 /home/group/
$ sudo chmod +t /home/group/
$ sudo cp /etc/samba/smb.conf /etc/samba/smb.conf_backup
$ sudo gedit /etc/samba/smb.conf

4. Find this line 

...
;   security = user
...

5. Replace with the following line 

   security = user

6. Find this section 

...
# This boolean controls whether PAM will be used for password changes
# when requested by an SMB client instead of the program listed in
# 'passwd program'. The default is 'no'.
;   pam password change = no
...

7. Add the following line below it 
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   username map = /etc/samba/smbusers

8. Append the following lines at the end of file 

[Group]
   comment = Group Folder
   path = /home/group
   public = yes
   writable = yes
   valid users = your_system_username1 your_system_username2
   create mask = 0700
   directory mask = 0700
   force user = nobody
   force group = nogroup

9. Save the edited file (sample) 
10.Read How to add/edit/delete network users? 

11.$ sudo testparm
$ sudo /etc/init.d/samba restart

Q: How to share public folder with read only permission (Authentication=Yes)?

1. Read General Notes 
2. Read How to install Samba Server for file sharing service? 

3. $ sudo mkdir /home/public
$ sudo chmod 777 /home/public/
$ sudo chmod +t /home/public/
$ sudo cp /etc/samba/smb.conf /etc/samba/smb.conf_backup
$ sudo gedit /etc/samba/smb.conf

4. Find this line 

...
;   security = user
...

5. Replace with the following line 

   security = user

6. Find this section 

...
# This boolean controls whether PAM will be used for password changes
# when requested by an SMB client instead of the program listed in
# 'passwd program'. The default is 'no'.
;   pam password change = no
...

7. Add the following line below it 

   username map = /etc/samba/smbusers

8. Append the following lines at the end of file 

[public]
   comment = Public Folder
   path = /home/public
   public = yes
   writable = no
   create mask = 0777
   directory mask = 0777
   force user = nobody
   force group = nogroup

9. Save the edited file (sample) 
10.Read How to add/edit/delete network users? 

11.$ sudo testparm
$ sudo /etc/init.d/samba restart

Q: How to share public folder with read/write permissions (Authentication=Yes)?

1. Read General Notes 
2. Read How to install Samba Server for file sharing service? 

3. $ sudo mkdir /home/public
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$ sudo chmod 777 /home/public/
$ sudo chmod +t /home/public/
$ sudo cp /etc/samba/smb.conf /etc/samba/smb.conf_backup
$ sudo gedit /etc/samba/smb.conf

4. Find this line 

...
;   security = user
...

5. Replace with the following line 

   security = user

6. Find this section 

...
# This boolean controls whether PAM will be used for password changes
# when requested by an SMB client instead of the program listed in
# 'passwd program'. The default is 'no'.
;   pam password change = no
...

7. Add the following line below it 

   username map = /etc/samba/smbusers

8. Append the following lines at the end of file 

[public]
   comment = Public Folder
   path = /home/public
   public = yes
   writable = yes
   create mask = 0777
   directory mask = 0777
   force user = nobody
   force group = nogroup

9. Save the edited file (sample) 
10.Read How to add/edit/delete network users? 

11.$ sudo testparm
$ sudo /etc/init.d/samba restart

Q: How to share public folder with read only permission (Authentication=No)?

1. Read General Notes 
2. Read How to install Samba Server for file sharing service? 

3. $ sudo mkdir /home/public
$ sudo chmod 777 /home/public/
$ sudo chmod +t /home/public/
$ sudo cp /etc/samba/smb.conf /etc/samba/smb.conf_backup
$ sudo gedit /etc/samba/smb.conf

4. Find this line 

...
;   security = user
...

5. Replace with the following line 

   security = share

6. Append the following lines at the end of file 

[public]
   comment = Public Folder
   path = /home/public
   public = yes
   writable = no
   create mask = 0777
   directory mask = 0777
   force user = nobody
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   force group = nogroup

7. Save the edited file (sample) 

8. $ sudo testparm
$ sudo /etc/init.d/samba restart

Q: How to share public folder with read/write permissions (Authentication=No)?

1. Read General Notes 
2. Read How to install Samba Server for file sharing service? 

3. $ sudo mkdir /home/public
$ sudo chmod 777 /home/public/
$ sudo chmod +t /home/public/
$ sudo cp /etc/samba/smb.conf /etc/samba/smb.conf_backup
$ sudo gedit /etc/samba/smb.conf

4. Find this line 

...
;   security = user
...

5. Replace with the following line 

   security = share

6. Append the following lines at the end of file 

[public]
   comment = Public Folder
   path = /home/public
   public = yes
   writable = yes
   create mask = 0777
   directory mask = 0777
   force user = nobody
   force group = nogroup

7. Save the edited file (sample) 

8. $ sudo testparm
$ sudo /etc/init.d/samba restart

SSH Server

Q: How to install SSH Server for remote administration service?

1. Read General Notes 
2. Read How to add extra repositories? 

3. $ sudo apt-get install ssh

Q: How to SSH into remote Ubuntu machine?

1. Read General Notes 
2. e.g. Assumed that remote Ubuntu machine had installed SSH Server service

     Read How to install SSH Server for remote administration service?
     Remote Ubuntu machine: 192.168.0.1

3. $ ssh username@192.168.0.1

Q: How to copy file/folder from remote Ubuntu machine into local machine (scp)?

1. Read General Notes 
2. e.g. Assumed that remote Ubuntu machine had installed SSH Server service

     Read How to install SSH Server for remote administration service?
     Remote Ubuntu machine: 192.168.0.1
     Remote file/folder location: /home/username/remotefile.txt
     Local machine save location: . (current directory)
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3. $ scp -r username@192.168.0.1:/home/username/remotefile.txt .

Q: How to copy file/folder from local machine into remote Ubuntu machine (scp)?

1. Read General Notes 
2. e.g. Assumed that remote Ubuntu machine had installed SSH Server service

     Read How to install SSH Server for remote administration service?
     Local file/folder location: localfile.txt
     Remote Ubuntu machine: 192.168.0.1
     Remote Ubuntu machine save location: /home/username/

3. $ scp -r localfile.txt username@192.168.0.1:/home/username/

Q: How to copy file/folder from remote Ubuntu machine into local machine (rsync)?

1. Read General Notes 
2. e.g. Assumed that remote Ubuntu machine had installed SSH Server service

     Read How to install SSH Server for remote administration service?
     Remote Ubuntu machine: 192.168.0.1
     Remote file/folder location: /home/username/remotefile.txt
     Local machine save location: . (current directory)

3. $ rsync -v -u -a --delete --rsh=ssh --stats username@192.168.0.1:/home/username/remotefile.txt 
.

Q: How to copy file/folder from local machine into remote Ubuntu machine (rsync)?

1. Read General Notes 
2. e.g. Assumed that remote Ubuntu machine had installed SSH Server service

     Read How to install SSH Server for remote administration service?
     Local file/folder location: localfile.txt
     Remote Ubuntu machine: 192.168.0.1
     Remote Ubuntu machine save location: /home/username/

3. $ rsync -v -u -a --delete --rsh=ssh --stats localfile.txt username@192.168.0.1:/home/username/

Q: How to SSH into remote Ubuntu machine via Windows machine?

1. Read General Notes 
2. e.g. Assumed that remote Ubuntu machine had installed SSH Server service

     Read How to install SSH Server for remote administration service?

3. Download PuTTY: Here or Here 

Q: How to copy file/folder from/into remote Ubuntu machine via Windows machine?

1. Read General Notes 
2. e.g. Assumed that remote Ubuntu machine had installed SSH Server service

     Read How to install SSH Server for remote administration service?

3. Download WinSCP: Here or Here 

DHCP Server

Q: How to install DHCP Server for automatic IP address assignment?

1. Read General Notes 
2. Read How to add extra repositories? 

3. e.g. Assumed that "eth0" is the interface for network card
     IP Address Range: 192.168.0.100 to 192.168.0.200
     Subnet Mask: 255.255.255.0
     DNS Servers: 202.188.0.133, 202.188.1.5
     Domains: tm.net.my
     Gateway Address: 192.168.0.1

4. $ sudo apt-get install dhcp3-server
$ sudo cp /etc/default/dhcp3-server /etc/default/dhcp3-server_backup
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$ sudo gedit /etc/default/dhcp3-server

5. Find this line 

...
INTERFACES=""

6. Replace with the following line 

INTERFACES="eth0"

7. Save the edited file (sample) 

8. $ sudo cp /etc/dhcp3/dhcpd.conf /etc/dhcp3/dhcpd.conf_backup
$ sudo gedit /etc/dhcp3/dhcpd.conf

9. Find this section 

...
# option definitions common to all supported networks...
option domain-name "example.org";
option domain-name-servers ns1.example.org, ns2.example.org;

default-lease-time 600;
max-lease-time 7200;
...

10.Replace with the following lines 

# option definitions common to all supported networks...
#option domain-name "example.org";
#option domain-name-servers ns1.example.org, ns2.example.org;

#default-lease-time 600;
#max-lease-time 7200;

11.Find this section 

...
# A slightly different configuration for an internal subnet.
#subnet 10.5.5.0 netmask 255.255.255.224 {
#  range 10.5.5.26 10.5.5.30;
#  option domain-name-servers ns1.internal.example.org;
#  option domain-name "internal.example.org";
#  option routers 10.5.5.1;
#  option broadcast-address 10.5.5.31;
#  default-lease-time 600;
#  max-lease-time 7200;
#}
...

12.Replace with the following lines 

# A slightly different configuration for an internal subnet.
subnet 192.168.0.0 netmask 255.255.255.0 {
  range 192.168.0.100 192.168.0.200;
  option domain-name-servers 202.188.0.133, 202.188.1.5;
  option domain-name "tm.net.my";
  option routers 192.168.0.1;
  option broadcast-address 192.168.0.255;
  default-lease-time 600;
  max-lease-time 7200;
}

13.Save the edited file (sample) 

14.$ sudo /etc/init.d/dhcp3-server restart

Database Server

Q: How to install MYSQL Database Server?
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1. Read General Notes 
2. Read How to add extra repositories? 

3. $ sudo apt-get install mysql-server
$ sudo /usr/bin/mysqladmin -u root password your_db_user_password

Apache HTTP Server

Q: How to install Apache HTTP Server for HTTP (Web) Server service?

1. Read General Notes 
2. Read How to add extra repositories? 

3. $ sudo apt-get install apache2

4. http://localhost   

Q: How to install PHP for Apache HTTP Server?

1. Read General Notes 
2. Read How to add extra repositories? 
3. Read How to install Apache HTTP Server for HTTP (Web) Server service? 

4. $ sudo apt-get install php4
$ sudo apt-get install libapache2-mod-php4
$ sudo /etc/init.d/apache2 force-reload
$ sudo gedit /var/www/testphp.php

5. Insert the following line into the new file 

<?php phpinfo(); ?>

6. Save the edited file (sample) 
7. http://localhost/testphp.php   

Q: How to install MYSQL for Apache HTTP Server?

1. Read General Notes 
2. Read How to add extra repositories? 
3. Read How to install Apache HTTP Server for HTTP (Web) Server service? 
4. Read How to install MYSQL Database Server? 
5. Read How to install PHP for Apache HTTP Server? 

6. $ sudo apt-get install libapache2-mod-auth-mysql
$ sudo apt-get install php4-mysql
$ sudo /etc/init.d/apache2 restart

Tips & Tricks

Q: How to apt-get the easy way (Synaptic)?

1. Read General Notes 
2. Computer -> System Configuration -> Synaptic Packager Manager 
3. Synaptic Package Manager 

1. To refresh the list of known packages (equivalent to apt-get update) 

Edit Menu -> Reload Package List

2. To install all possible upgrades (equivalent to apt-get upgrade) 
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Edit Menu -> Mark All Upgrades... -> Default Upgrade
Edit Menu -> Apply Marked Changes

3. To search for a package (equivalent to apt-cache search package_name) 

Edit Menu -> Search... (Specify the package name in Search box)

4. To install the selected package (equivalent to apt-get install package_name) 

Select the package to be installed

Package Menu -> Mark for Installation
Edit Menu -> Apply Marked Changes

5. To remove installed package (equivalent to apt-get remove package_name) 

Select the package to be removed

Package Menu -> Mark for Removal
Edit Menu -> Apply Marked Changes

Q: How to load Web site faster in Mozilla Firefox (disable IPv6)?

1. Read General Notes 
2. Applications -> Internet -> Mozilla Firefox 
3. Mozilla Firefox 

Address Bar -> about:config

Filter: -> network.dns.disableIPv6 -> Change the Value to true (Double click)

Q: How to disable beep sound for link find function in Mozilla Firefox?

1. Read General Notes 
2. Applications -> Internet -> Mozilla Firefox 
3. Mozilla Firefox 

Address Bar -> about:config

Filter: -> accessibility.typeaheadfind.enablesound -> Change the Value to false (Double click)

Q: How to open each folder in the same window in Nautilus?

1. Read General Notes 
2. To temporary open each folder in the same window in Nautilus 

1. Double click with the middle (wheel) mouse button 
3. To permanently open each folder in the same window in Nautilus 

1. Applications -> System Tools -> Configuration Editor 
2. GConf editor - 

/ -> apps -> nautilus -> preferences -> always_use_browser (Checked)

Q: How to show all hidden files in Nautilus?

1. Read General Notes 
2. Computer -> Home 
3. To temporary show all hidden files in Nautilus 

1. Press 'Ctrl + H' 
4. To permanently show all hidden files in Nautilus 

1. Edit Menu -> Preferences

Views Tab -> Default View -> Show hidden and backup files (Checked)

Q: How to show Desktop Icons (Computer, Home, Trash)?

1. Read General Notes 
2. Applications -> System Tools -> Configuration Editor 
3. GConf editor - 

/ -> apps -> nautilus -> desktop ->
computer_icon_visible (Checked)



home_icon_visible (Checked)
trash_icon_visible (Checked)

Q: How to turn on Num Lock when login into GNOME?

1. Read General Notes 
2. Read How to add extra repositories? 

3. $ sudo apt-get install numlockx

Q: How to keep the content of clipboard into memory in GNOME?

1. Read General Notes 
2. Download gnome-clipboard-daemon-1.0.bin.tar.bz2: Here or Here 

3. $ cd browse_to_your_download_folder
$ sudo tar jxvf gnome-clipboard-daemon-1.0.bin.tar.bz2 -C /usr/bin/
$ sudo chown root:root /usr/bin/gnome-clipboard-daemon
$ sudo chmod 755 /usr/bin/gnome-clipboard-daemon
$ sudo /usr/bin/gnome-clipboard-daemon &

4. Computer -> Desktop Preferences -> Sessions 
5. Sessions 

Startup Programs Tab -> Add ->
Startup Command: /usr/bin/gnome-clipboard-daemon
Order: 80

Q: How to run programs on startup when login into GNOME?

1. Read General Notes 
2. Computer -> Desktop Preferences -> Sessions 
3. Sessions 

Startup Programs Tab -> Add/Edit/Delete programs

Q: How to change default file type "Open with" program?

1. Read General Notes 

2. Right click on file -> Properties

Open With Tab -> Add
Select the added open with program (Checked)

Q: How to restart GNOME without rebooting computer?

1. Read General Notes 
2. Save and close all opened applications 
3. Press 'Ctrl + Alt + Backspace' 

Q: How to switch to Console mode in GNOME?

1. Read General Notes 
2. To switch to Console mode 

1. Press 'Ctrl + Alt + F1' (F2 - F6) 
3. To switch back to GNOME mode 

1. Press 'Ctrl + Alt + F7' 

Q: How to disable beep sound in Terminal mode?

1. Read General Notes 
2. Applications -> System Tools -> Terminal 
3. Terminal 

Edit Menu -> Current Profile...

General Tab -> General -> Terminal bell (Un-Checked)

Q: How to remount /etc/fstab without rebooting?

1. Read General Notes 
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2. $ sudo mount -a

Q: How to unhide GRUB menu on boot-up?

1. Read General Notes 

2. $ sudo cp /boot/grub/menu.lst /boot/grub/menu.lst_backup
$ sudo gedit /boot/grub/menu.lst

3. Find this line 

...
hiddenmenu
...

4. Replace with the following line 

#hiddenmenu

5. Save the edited file (sample) 

Q: How to change the timeout seconds for GRUB menu on boot-up?

1. Read General Notes 

2. $ sudo cp /boot/grub/menu.lst /boot/grub/menu.lst_backup
$ sudo gedit /boot/grub/menu.lst

3. Find this line 

...
timeout         3
...

4. Replace with the following line 

timeout         X_seconds

5. Save the edited file (sample) 

Q: How to change default Operating System boot-up for GRUB menu?

1. Read General Notes 

2. $ sudo cp /boot/grub/menu.lst /boot/grub/menu.lst_backup
$ sudo gedit /boot/grub/menu.lst

3. Find this line 

...
default         0
...

4. Replace with the following line 

default         X_sequence

5. Save the edited file (sample) 

Q: How to temporary skip boot-up service?

1. Read General Notes 
2. Press 'Ctrl + C' 

Q: How to permanently disable/enable boot-up service?

1. Read General Notes 
2. To permanently disable boot-up service 

$ sudo chmod -x /etc/init.d/service_name

3. To permanently enable boot-up service 
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$ sudo chmod +x /etc/init.d/service_name

Q: How to upgrade from Warty Warthog to Hoary Hedgehog (Beta)?

1. Read General Notes 

2. $ sudo cp /etc/apt/sources.list /etc/apt/sources.list_backup
$ sudo gedit /etc/apt/sources.list

3. Find this section 

...
## Uncomment the following two lines to fetch updated software from the network
# deb http://archive.ubuntu.com/ubuntu warty main restricted
# deb-src http://archive.ubuntu.com/ubuntu warty main restricted

## Uncomment the following two lines to add software from the 'universe'
## repository.
## N.B. software from this repository is ENTIRELY UNSUPPORTED by the Ubuntu
## team, and may not be under a free licence. Please satisfy yourself as to
## your rights to use the software. Also, please note that software in
## universe WILL NOT receive any review or updates from the Ubuntu security
## team.
# deb http://archive.ubuntu.com/ubuntu warty universe
# deb-src http://archive.ubuntu.com/ubuntu warty universe

# deb http://security.ubuntu.com/ubuntu warty-security main restricted
# deb-src http://security.ubuntu.com/ubuntu warty-security main restricted
...

4. Replace with the following lines 

## Uncomment the following two lines to fetch updated software from the network
deb http://archive.ubuntu.com/ubuntu/ hoary main restricted
deb-src http://archive.ubuntu.com/ubuntu/ hoary main restricted

## Uncomment the following two lines to add software from the 'universe'
## repository.
## N.B. software from this repository is ENTIRELY UNSUPPORTED by the Ubuntu
## team, and may not be under a free licence. Please satisfy yourself as to
## your rights to use the software. Also, please note that software in
## universe WILL NOT receive any review or updates from the Ubuntu security
## team.
deb http://archive.ubuntu.com/ubuntu/ hoary universe
deb-src http://archive.ubuntu.com/ubuntu/ hoary universe

deb http://security.ubuntu.com/ubuntu/ hoary-security main restricted
deb-src http://security.ubuntu.com/ubuntu/ hoary-security main restricted

5. Save the edited file (sample) 

6. $ sudo apt-get update
$ sudo apt-get dist-upgrade

Troubleshooting

Q: Configuring network interfaces... (taking too long to load)

1. Read General Notes 
2. Read How to temporary skip boot-up service? 
3. Read How to permanently disable/enable boot-up service? 

service_name = networking

Q: Synchronizing clock to ntp.ubuntulinux.org... (taking too long to load)

1. Read General Notes 
2. Read How to temporary skip boot-up service? 
3. Read How to permanently disable/enable boot-up service? 

http://ubuntuguide.org/4.10/sample/sources.list_upgradewartytohoary


service_name = ntpdate

Q: modprobe: FATAL: Error inserting...

1. Read General Notes 

2. $ sudo cp /etc/hotplug/blacklist /etc/hotplug/blacklist_backup
$ sudo gedit /etc/hotplug/blacklist

3. Depends on the Error shown, append the following lines at the end of file 

pciehp
shpchp
hw_random

4. Save the edited file (sample) 

Q: acpi_power_off called

1. Read General Notes 

2. $ sudo cp /boot/grub/menu.lst /boot/grub/menu.lst_backup
$ sudo gedit /boot/grub/menu.lst

3. Find this section 

...
title           Ubuntu, kernel 2.6.8.1-4-386
root            (hd0,0)
kernel          /boot/vmlinuz-2.6.8.1-4-386 root=/dev/hda1 ro quiet splash
...

4. Replace with the following lines 

title           Ubuntu, kernel 2.6.8.1-4-386
root            (hd0,0)
kernel          /boot/vmlinuz-2.6.8.1-4-386 root=/dev/hda1 ro quiet splash acpi=off apm=off

5. Save the edited file (sample) 

6. $ sudo cp /etc/modules /etc/modules_backup
$ sudo gedit /etc/modules

7. Append the following line at the end of file 

apm

8. Save the edited file (sample) 

Q: Sorry, no mixer elements and/or devices found

1. Read General Notes 

2. $ gst-register-0.8

Q: How to disable system date/time from being reset to UTC (GMT)?

1. Read General Notes 

2. $ sudo cp /etc/default/rcS /etc/default/rcS_backup
$ sudo gedit /etc/default/rcS

3. Find this line 

...
UTC=yes
...

4. Replace with the following line 

UTC=no

5. Save the edited file (sample) 
6. Computer -> System Configuration -> Time and Date 

Set the correct date/time

http://ubuntuguide.org/4.10/sample/rcS_disablesystemdatetimeutc
http://ubuntuguide.org/4.10/sample/modules_acpipoweroff
http://ubuntuguide.org/4.10/sample/menu.lst_acpipoweroff
http://ubuntuguide.org/4.10/sample/blacklist_modprobefatalerror


7. $ sudo /etc/init.d/hwclock.sh restart

Q: How to forcefully empty Trash?

1. Read General Notes 

2. $ sudo rm -fr $HOME/.Trash/

Acknowledgements

This guide was made possible thanks to these people, for which would like to express my greatest 
appreciation. Please accept my apologies in advance if I have missed out your Web site/name

People from these Web sites

1. http://www.ubuntulinux.org   

People from these forums

1. http://www.ubuntuforums.org   
2. http://www.desktopos.com   

People from these IRC channel

1. irc://irc.freenode.net/ubuntu   

People that contributed in this guide (sorted by name/nick)

1. dare2dreamer 
1. How to enhance NVIDIA graphics performance?   
2. How to keep the content of clipboard into memory in GNOME?   

2. Emmanuel SCHRODER 
1. How to use "sudo" without prompt for password (not secure)?   

3. Gabriel Molina 
1. How to copy file/folder from remote Ubuntu machine into local machine (rsync)?   
2. How to copy file/folder from local machine into remote Ubuntu machine (rsync)?   

4. Julien Rottenberg 
1. How to mount/unmount Image (ISO) file without burning?   

5. Matjaz Horvat 
1. How to create Image (ISO) file from folder?   

6. Michael Schroeder 
1. Gave the design/template for the beautified version of this guide (XHTML, CSS) 

7. Rancoras 
1. How to disable system date/time from being reset to UTC (GMT)?   

8. People that gave some inputs and corrections to this guide 
1. clparker 
2. jdong 
3. Khad Young 
4. khermans 
5. Oliver Grawert 
6. phatbob 
7. Rodd R. Ahrenstorff 
8. Samuel Wright 
9. Simon Taplin 

9. Please accept my apologies in advance if I have missed out your name/nick. Just send me an email, 
and I will be glad to put you on the list here 

  

irc://irc.freenode.net/ubuntu
http://www.desktopos.com/modules/newbb/viewforum.php?forum=10
http://www.ubuntuforums.org/
http://www.ubuntulinux.org/
http://validator.w3.org/check?uri=referer
http://jigsaw.w3.org/css-validator/check/referer


Ubuntu Logo, Ubuntu and Canonical are trademarks of Canonical Ltd.

  

, 09.01.06
HTML: <noscript>

, 09.01.06
HTML: </noscript>

http://www.ubuntulinux.org/
http://t.extreme-dm.com/?login=ug410

	Disclaimer
	General Notes
	Topics
	Getting Started
	Repositories
	Ubuntu Updates
	Add-On Applications
	Hardware
	CD/DVD Burning
	Networking
	Security
	Rescue Mode
	Windows
	Users Administration
	Samba Server
	SSH Server
	DHCP Server
	Database Server
	Apache HTTP Server
	Tips & Tricks
	Troubleshooting
	Acknowledgements

	Getting Started
	Repositories
	Ubuntu Updates
	Add-On Applications
	Hardware
	CD/DVD Burning
	Networking
	Security
	Rescue Mode
	Windows
	Users Administration
	Samba Server
	SSH Server
	DHCP Server
	Database Server
	Apache HTTP Server
	Tips & Tricks
	Troubleshooting
	Acknowledgements

	q: 
	sa: 


